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Notice
The information contained in this document is subject to change without 
notice.

Hewlett-Packard Company (HP) shall not be liable for any errors contained 
in this document. HP makes no warranties of any kind with regard to this 
document, whether express or implied. HP specifically disclaims the implied 
warranties of merchantability and fitness for a particular purpose. HP shall 
not be liable for any direct, indirect, special, incidental, or consequential 
damages, whether based on contract, tort, or any other legal theory, in 
connection with the furnishing of this document or the use of the 
information in this document.

Warranty Information

A copy of the specific warranty terms applicable to your Hewlett-Packard 
product and replacement parts can be obtained from your local Sales and 
Service Office.

U.S. Government Restricted Rights

The Software and Documentation have been developed entirely at private 
expense. They are delivered and licensed as “commercial computer 
software” as defined in DFARS 252.227-7013 (Oct 1988), 
DFARS 252.211-7015 (May 1991) or DFARS 252.227-7014 (Jun 1995),
as a “commercial item” as defined in FAR 2.101(a), or as “Restricted 
computer software” as defined in FAR 52.227-19 (Jun 1987) (or any 
equivalent agency regulation or contract clause), whichever is applicabl
You have only those rights provided for such Software and Documentat
by the applicable FAR or DFARS clause or the HP standard software 
agreement for the product involved.

Copyright  1996, 1997 Hewlett-Packard Company. All rights reserved.

This document contains information which is protected by copyright. All
rights are reserved.  Reproduction, adaptation, or translation without pri
written permission is prohibited, except as allowed under the copyright la
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About This Manual
This manual describes the HP E6237A VXI Pentium Real-Time Controller 
development system, and helps you get started using it. First, you should 
install the controller as explained in the manual, VXI Pentium Controller: 
Hardware Installation and Configuration Guide. After installing the 
controller, refer to this manual for information about completing the system 
configuration, the documentation, troubleshooting aid, getting technical 
support, and basic hardware layout and configuration. The following 
chapters and appendixes contain the information:

n Chapter 1 - Getting Started helps you complete the system setup, tells 
how to get started using the system, describes the Hewlett-Packard and 
LynxOS documentation sets, and explains how to get technical support.

n Chapter 2 - Troubleshooting provides troubleshooting information such 
as front-panel LED indications, and BIOS error messages.

n Chapter 3 - Using the BIOS Setup Utility explains how to configure 
the system BIOS.

n Chapter 4 - Re-Installing the System Software explains how to re-
install the system software if files are corrupted or other system changes 
are required.

n Appendix A - LEDs on the Front Panel describes the controller’s front
panel LEDs.

n Appendix B - I/O, Memory, and IRQ Details describes I/O, Memory, 
and IRQ details about the controller.

n Appendix C - POST Beep Codes lists the Power On Self Test (POST) 
beep codes which are used for troubleshooting purposes.

n Appendix D - Specifications lists the controller hardware’s 
environmental and electrical specifications.
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Conventions Used in This Manual
This manual uses the following typographical conventions:

Getting Started Italicized text is used for book titles and for 
emphasis.

Dialog Box Bold text is used for the first instance of a word 
that is defined in the glossary.

File Computer font represents text that you will see 
on the screen, including menu names, features, 
buttons, or text that you have to enter.

dir filename In this context, the text in computer font 
represents an argument that you type exactly as 
shown, and the italicized text represents an 
argument that you must replace with an actual 
value.

File ⇒ Open The “⇒” is used in a shorthand notation to show 
the location of features in the menu. For 
example, “File ⇒ Open” means to select the 
File menu and then select Open.

Sml | Med | Lrg Choices in computer font, separated with bars 
(|), indicate that you should choose one of the 
options.

Press Enter In this context, bold represents a key to press on
the keyboard.

Press Ctrl + O Represents a combination of keys on the 
keyboard that you should press at the same time
 v
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Getting Started

This chapter will help you complete the development system setup and tell 
you how to get started using the HP E6237A VXI Pentium Real-Time 
Controller. It also describes the Hewlett-Packard and LynxOS 
documentation sets, and explains how to get technical support. The 
following list describes the system’s major components:

n HP E6237A VXI Pentium Controller and VXI mainframe: The 
controller should already be installed and configured as explained in 
Hardware Installation and Configuration Guide.

The controller arrives from the factory with all system software pre-
installed and configured. The system software includes the LynxOS 
operating system, the HP Standard Instrument Control Library 
(HP SICL), the HP Compiled Standard Commands for Programmabl
Instruments (HP C-SCPI), and software from the Free Software 
Foundation. The next section explains how to complete the system se
and start using the controller.

n Documentation: Hewlett-Packard and Lynx documentation will help 
you develop applications. The documentation is available as printed 
manuals and as online files. Later sections in this chapter describe th
documentation.

n Installation Media: The development system includes one CD-ROM 
labeled “E6237A Development System”, and one 3.5-inch floppy disk
labeled “E6237A Installation Disk”. Use these disks if you ever need 
re-install the system software. The CD-ROM contains an image of th
system software, as well as a copy the entire LynxOS file system, the
source code from the Free Software Foundation, and online 
documentation files. The floppy disk is the LynxOS boot disk. See 
Chapter 4, “Re-Installing the System Software”, for details about usin
the installation media.
2 Chapter 1 
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Starting the System
Starting the System
After the controller hardware is installed and configured, and you have 
completed the system setup, you are ready to start using the development 
system. For information about starting and stopping the system, and other 
introductory information about using LynxOS, see the LynxOS Quick Start 
Guide. However, before you begin doing any real work, you must complete 
some final setup tasks.

Note See the file /README for information about system software installation and 
configuration that was not included in this manual.

Verifying the System Software Configuration

You should verify the system software configuration now. You may need to 
change some configuration settings. The controller arrives from the factory 
with LynxOS and the I/O libraries (HP SICL and HP C-SCPI) pre-installed 
with default configurations. These installations are done according to 
procedures typically used to install the system software components as 
individual products. For configuration information about the I/O libraries, 
see the HP SICL User’s Guide for LynxOS and the HP C-SCPI User’s Guide. 
The remainder of this section will help you verify the LynxOS configuration 
settings, and change those that are incorrect for your environment. Also, it is 
useful for you to know how LynxOS is installed.

Caution LynxOS is shipped from the factory without password protection on the 
root or setup accounts.

Changing LynxOS 
Configuration

Some of the configuration settings depend on the specific user environment 
and must be configured by the user. The following list identifies the 
configuration tasks to complete, and the settings to verify. Be sure to change 
settings as needed. See the LynxOS Installation Guide and the LynxOS 
User’s Guide for details about these topics.
Chapter 1 3
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Starting the System
n Verify operating system settings:

q Create user accounts as explained in the LynxOS User’s Guide.

q Set the date and time using the /bin/date command, or the setup 
login.

q Set the time zone in the file /bin/rc, or use the setup login.

q Set the X Window and Motif configurations as explained in the 
LynxOS Installation Guide.

q The installed LynxOS system includes X and Motif, including 
PosixWorks Desk. In order to remain backward compatible with 
previous offerings from HP, PosixWorks Desk is disabled from 
running automatically at bootup. To run PosixWorks Desk manually 
after bootup, execute the following command at the command 
prompt:

startx

To run PosixWorks Desk automatically at bootup, edit the file
/etc/ttys. In the line beginning with /dev/atc2, change the
0 to 1. The resulting line should look like the following example:

/dev/atc2:1:default:vt100at:/bin/runx

n Verify network settings:

q Set the host name in /net/rc.network.

q Correct the host table in /etc/hosts.

q Set NFS mounts in /etc/fstab.

Factory-Installation 
Procedure

The factory installation of LynxOS on the HP VXI Pentium Controller 
follows the installation and configuration procedure described in the LynxOS 
Installation Guide. The following list outlines the main steps in the factory-
installation procedure. This can be useful information if you contact Lynx 
for technical support. The installation media supplied with your system by 
4 Chapter 1 
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Re-

Hewlett-Packard duplicates the factory-installation procedure, and should be 
used only if you need to re-install the system software; see Chapter 4, “
Installing the System Software”, for more information.

n Load LynxOS:

q Load on IDE, first partition (hd0a).
q Choose “Development System Values”.
q Enable virtual memory on IDE, second partition (hd0b).
q Configure networking on AMD AM79C970A.

l TCP/IP: yes
l Hostname / IP: lynxdemo / 10.0.0.1
l NFS: all yes
l STREAMS: all yes

n Configure LynxOS:

q In /sys/lynx.os/uparam.h, increase USR_PPSMEMS from 16 to 
32, and SMEMS from 10 to 20.

q Enable two virtual consoles: atc0 and atc1.
q Install various LynxOS patches. (See /README for details.)
q Install PS/2 mouse driver.

n Load and configure X and Motif:

q Install all products with default settings.
q Configure for Microsoft®-compatible PS/2 mouse.

n Load PosixWorks Desk tools:

q Load TotalView Multi-Process Debugger.
q Load TimeScan Performance Analyzer.

n Load and configure HP I/O Libraries:

q Load and configure HP SICL.
q Load and configure HP C-SCPI.
Chapter 1 5
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Guide to Hewlett-Packard Documentation
The HP E6237A includes documentation describing the hardware and 
software components supplied by Hewlett-Packard. This chapter describes 
the following Hewlett-Packard documentation sets.

n HP E6237A VXI Pentium Controller Documentation
Hardware Installation and Configuration Guide
User’s Guide for Real-Time Controller (this manual)
User’s Guide for Run-Only System (included with run-only system 
option)

n HP SICL Documentation
User’s Guide for LynxOS
Reference Manual
Quick Reference Guide for C Programmers

n HP Compiled SCPI for LynxOS Documentation
User’s Guide
HP C-SCPI Quick Reference Guide

The printed HP manuals are also available as PDF documents readable 
online by the Adobe™ Acrobat Reader. To view these documents, you m
acquire a copy of the Acrobat Reader application, and install it on a PC 
running Microsoft® Windows® 95 or Windows NT®. The PDF documen
are on the “HP E6237A Development System” CD-ROM in the /pdf_doc 
directory. The Acrobat Reader is available for free, as a downloadable f
from the Adobe web site at www.adobe.com. After downloading the reader,
its online instructions explain how to view PDF documents.

HP E6237A VXI Pentium Controller Documentation

The Pentium controller documentation explains how to install and config
the controller hardware, and provides general information about using th
real-time controller system.
6 Chapter 1 



Getting Started
Guide to Hewlett-Packard Documentation
Hardware Installation and Configuration Guide explains how to install the 
VXI Pentium Controller hardware, including any peripherals you wish to 
connect to the controller. This guide then explains how to power up the 
controller and customize the controller’s configuration if the default, 
factory-set configuration is not sufficient for your controller’s specific 
hardware setup.

User’s Guide for Real-Time Controller is this manual. It explains how to use 
your system by describing the documentation, basic installation/
configuration procedures, troubleshooting aid, and support information.

User’s Guide for Run-Only System is included with the run-only system 
option. It describes the run-only system, explains how to move your 
application from the development system to the run-only system, and how to 
re-install the run-only system software if necessary.

HP SICL Documentation

Use the HP SICL (Standard Instrument Control Library) documentation 
when including the library in your applications that control instruments. 
SICL provides program portability across a variety of computer 
architectures, I/O interfaces, and operating systems. SICL also provides 
commands to take advantage of the unique features of each type of interface, 
thus giving the programmer complete control over I/O communications.

User’s Guide for LynxOS describes how to configure and use SICL on 
LynxOS.

The SICL Reference Manual provides the function syntax and description of 
each SICL function.

Quick Reference Guide for C Programmers helps you find SICL function 
syntax information quickly if you are programming in C/C++.

All commands are documented online as man pages in text format. Use the 
man command to view this information:

man cmd_name 
Chapter 1 7
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HP Compiled SCPI for LynxOS Documentation

Use the HP C-SCPI (Compiled Standard Commands for Programmable 
Instruments) documentation when you include SCPI commands in your 
programs. Compiled SCPI lets you achieve the high throughput of register-
based VXI devices with the ease of high-level programming.

User’s Guide provides detailed information about how to use Compiled 
SCPI. Example C-SCPI programs and troubleshooting information are 
provided as well.

HP C-SCPI Quick Reference Guide summarizes command syntax and 
descriptions, presents commands in their functional groups, and explains the 
process for you to include C-SCPI commands in a program.

All commands and instrument drivers are documented online as man pages 
in text format. Use the man command as shown in this example to view the 
information:

man cmd_name 
8 Chapter 1 
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Guide to LynxOS Documentation
The HP E6237A includes a complete set of programmer and reference 
documentation detailing the utilities and tools available with the LynxOS 
Real-Time Operating System. Use this documentation when you work 
directly with LynxOS. This chapter describes the LynxOS documentation set 
listed in the following table.

LynxOS Base Document Set Additional Documentation

LynxOS Installation Guide Lynx Real-Time Systems Datasheets

LynxOS User’s Guide TotalView Release Notes

Quick Start Guide TimeScan Release Notes

LynxOS Reference Manual Set LynxOS 2.5.0 Release Notes

Utility Programs (A-F) ELOG Library Programmer’s Guide

Utility Programs (G-O) TimeScan Viewer User’s Guide

Utility Programs (P-Z) TotalView User’s Guide

System Calls TotalView Supplement for LynxOS Users

Library Functions (A-M) Writing Device Drivers for LynxOS

Library Functions (N-Z) X Window System User’s Guide, Vol. 3, OSF/Motif 1.2 Edition

Device Facilities, File Formats
Driver Service Calls

Programmer’s Supplement for Release 6 of the
X Window System

GNU C/C++ Tools Set POSIX Programmer’s Guide

Using GNU CC POSIX.4: Programming for the Real World

Debugging with GDB

Development Support Tools

GNU Make

DejaGNU Testing Framework
Chapter 1 9
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Base Documentation Set

The base documentation set explains how to install and use LynxOS.

LynxOS Installation Guide explains how to install and configure LynxOS 
and the X Window® System. It also tells how to use X Window on LynxO
and describes some platform-specific details of booting LynxOS.

Note You cannot use the installation procedures described in the LynxOS 
documentation with your HP E6237A system. To install the system 
software, see Chapter 4, “Re-Installing the System Software”.

LynxOS User’s Guide explains basic system administration and kernel-level 
specifics of LynxOS. This includes topics such as tuning system 
performance, booting LynxOS over a network, and creating kernel images 
for embedded applications.

Quick Start Guide provides a quick overview of the steps needed to develop, 
compile, link, debug, and execute your applications using LynxOS.

LynxOS Reference Set

The LynxOS Reference contains many volumes, organized into the following 
functional sections:

n Section 1, Utility Programs (three volumes)

n Section 2, System Calls (one volume)

n Section 3, Library Functions (two volumes)

n Section 4, Device Facilities; Section 5, File Formats; Section 9, Driver 
Service Calls (combined into one volume)

All commands and utilities described in the LynxOS Reference and its 
supplements are available online in text format. Use the man command as 
shown in this example to view the information:

man gcc
10 Chapter 1 



Getting Started
Guide to LynxOS Documentation
GNU C/C++ Tools Set

This set describes the GNU C/C++ compilers and tools.

Using GNU CC explains how to use the GNU C compiler to compile 
programs written in C, C++, or Objective C.

Debugging with GDB explains how to debug C and C++ programs using the 
GNU debugger GDB.

Development Support Tools contains six sections that explain how to use 
various GNU support tools:

n CPP, the GNU C Preprocessor
n AS, the GNU Assemble
n GASP, the GNU Assembler Preprocessor
n LD, the GNU Linker
n The GNU Binary Utilities
n Comparing and Merging Files

GNU Make describes make and makefile, and how to use the GNU make 
utility.

DejaGNU Testing Framework describes DejaGNU as a framework for 
testing other programs, and explains how to set up a testing framework and 
test suites.

Additional Documentation

Release Notes for LynxOS, TimeScan, and TotalView contains late-breaking 
information about the latest release of these products.

TimeScan Viewer User’s Guide describes how to use the TimeScan Viewer, 
the graphical user interface to the TimeScan Performance Analyzer.

ELOG Library Programmer’s Guide covers the general use of the Event 
Logging (ELOG) Library, a component of the TimeScan Performance 
Analyzer.

TotalView User’s Guide describes how to use the TotalView Multi-Process 
Debugger, a source-level and machine-level debugger.

TotalView Supplement for LynxOS Users provides additional information 
about using the TotalView debugger on controllers running LynxOS.
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Writing Device Drivers for LynxOS describes LynxOS device drivers and 
gives numerous examples to help you write custom device drivers for many 
different situations.

POSIX Programmer’s Guide explains the POSIX standard and is a reference 
for the POSIX.1 programming library to help you write more portable 
programs. This guide is especially helpful if you are writing programs that 
must run on multiple UNIX® platforms.

POSIX.4: Programming for the Real World covers the POSIX.4 standard fo
portable real-time programming, and includes a general introduction to r
time programming with problem descriptions and associated solutions.

X Window System User’s Guide, vol. 3, OSF/Motif 1.2 Edition orients the 
new user to window system concepts and provides detailed tutorials for 
many client programs, including the xterm terminal emulator and window 
managers. Later chapters explain how to customize the X environment and 
provide sample configurations. 

Programmer’s Supplement for Release 6 of the X Window System is for 
programmers who are familiar with Release 5 and want to know how to use 
the new Release 6 features including complete tutorial and reference 
information for all new Xlib and Xt functions. This is an update to the 
Release 5 editions of volumes 1, 2, 4, and 5.
12 Chapter 1 
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Getting Technical Support
Your HP E6237A VXI Pentium Real-Time Controller contains components 
from two companies, Hewlett-Packard Company and LynxOS Real-Time 
Systems, Inc. If you should ever need technical support, it is important that 
you call the right company to get the quickest response to your concerns.

HP Support

For issues related to the controller hardware, the mainframe, configuration, 
or programming using SICL or C-SCPI, call for HP support and services at 
your local HP DIRECT office in the following list:

Austria 0660 8004

Belgium 02 778 3417

Canada 800-387-3154

France (1) 69.82.60.20

Germany (0 70 31) 14 63 33

Ireland 01 2844 633

Italy 02.92.122.241

Netherlands 020 547 6222

Norway 22 73 57 59

Spain (91) 631 13 23

Sweden 08 444 2525

Switzerland 01-735 72 00

United Kingdom 01344-366666

United States 800-452-4844
Chapter 1 13
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Countries without an HP DIRECT office should use the following phone 
numbers:

Lynx Support

For issues related to the LynxOS operating system, GNU tools set, 
TotalView and TimeScan operation, POSIX and X Window programming, 
contact Lynx Real-Time Systems. Use the technical support phone numbers 
listed in the front section of the following LynxOS manuals:

LynxOS Installation Guide 
LynxOS User’s Guide 
Quick Start Guide 

Access the Lynx web site at www.lynx.com for information about training 
and support, the user’s group, and other offerings.

Asia Pacific (852) 2599 7070

Australia
New Zealand

131 347 ext.2902

Japan (81) 426 48 3860

Latin America (305) 267 4245/4220
14 Chapter 1 
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Troubleshooting

This chapter helps you resolve error messages or other problems you may 
encounter while using the VXI Pentium Real-Time Controller. If you cannot 
resolve a problem, and you need to call for technical support, this chapter 
includes information that can help you describe symptoms to support 
personnel. This chapter contains the following sections:

n Front Panel LED Indications
n BIOS Error Messages
n Problems After Configuring the BIOS
n System Appears Hung Up

Note For information on the meaning of the LED indicators on the front panel of 
the controller, please see Appendix A, “LEDs on the Front Panel”.

If you need to use the BIOS setup utility, please see Chapter 3, “Using t
BIOS Setup Utility”.
16 Chapter 2 
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Front Panel LED Indications
If the controller is not operating correctly after powering it up, check the 
status of the front panel LEDs listed in the following table. They can help 
indicate the controller’s condition. At power-on, these LEDs should be lit
is normal for the TEST LED to go out part way through the boot; the SC
and IDE LEDs should go out after the boot. The following conditions ma
exist, depending on the LED indications.

Cycle the power to the controller to see if the problem rectifies itself. If t
LED indicators are still not lit correctly, then please contact your HP Serv
and Support Center for assistance. See the appendix in this manual, “P
Beep Codes”, for additional information that may be useful to service 
personnel.

Table 2-1. LED Indications

LED State Condition

RUN is not lit The CPU has halted.

TEST stays lit The controller did not pass its power-on self-test (POST).

SCSI stays lit SCSI port operation has failed.

IDE stays lit IDE disk error.
Chapter 2 17
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BIOS Error Messages
The following table lists the BIOS error messages you may encounter when 
powering up and using the VXI Pentium Controller, and describes possible 
causes and fixes for the errors.

Note If a possible fix that is suggested in the following table requires you to run 
BIOS Setup, please see Chapter 3, “Using the BIOS Setup Utility”, for m
information.

Table 2-2. BIOS Error Messages

Error Message Description

Diskette drive A error or 
Diskette drive B error

Drive A: or B: is present but fails the BIOS power-on self-
test (POST) for the particular 3.5-inch disk drive. Check to 
see that the drive is defined with the proper disk type in 
BIOS Setup. Also, if the disk drive is an external drive 
(rather than the internal drive), ensure that the disk drive is 
correctly connected.

EXM Configuration error The EXM module is not configured properly, or the BIOS 
cannot locate the module. Run BIOS Setup to correct the 
configuration.

Extended RAM Failed at offset: nnnn The extended memory is not working or is not configured 
properly at offset nnnn. Contact your HP Service and 
Support Center for assistance.

Failing Bits: nnnn The hexadecimal number nnnn is a map of the bits at the 
RAM address (in System, Extended, or Shadow memory) 
which failed the memory test. Each 1 (one) in the map 
indicates a failed bit. Contact your HP Service and Support 
Center for assistance.

Fixed Disk 0 Failure or 
Fixed Disk 1 Failure or 
Fixed Disk Controller Failure

The fixed disk (internal hard disk drive) is not working or is 
not configured properly. Run BIOS Setup to ensure the disk 
type is correctly identified. If this does not fix the problem, 
contact your HP Service and Support Center for assistance. 

Incorrect Drive A type - run SETUP or 
Incorrect Drive B type - run SETUP

The disk type for drive A: or B: is not correctly identified in 
BIOS Setup. Run BIOS Setup to set the correct disk type.

Invalid NVRAM media type There is a problem with NVRAM (CMOS) access. Contact 
your HP Service and Support Center for assistance.
18 Chapter 2 
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Keyboard controller error The keyboard controller failed a system test. You may have 
to replace either the keyboard or the keyboard controller. 
Contact your HP Service and Support Center for 
assistance.

Keyboard error - Keyboard not working 
Keyboard error nn

The system BIOS discovered a stuck key and displays the 
scan code nn for the stuck key.

Keyboard locked - Unlock key switch Unlock the system to proceed.

Monitor type does not match CMOS - Run 
SETUP

The monitor type is not correctly identified in BIOS Setup. 
Run BIOS Setup to set the correct monitor type.

Operating system not found The Windows operating system cannot be located on either 
drive C: or drive A:. Run BIOS Setup to ensure drive C: 
(fixed disk/internal hard disk drive) and/or drive A: (the 3.5-
inch disk drive) are properly identified.

Parity Check 1 A parity error was found in the system bus. If the system 
BIOS located the address where the parity error occurred, it 
will also display that address on the screen. Contact your 
HP Service and Support Center for assistance.

Parity Check 2 A parity error was found in the I/O bus. If the system BIOS 
located the address where the parity error occurred, it will 
also display it on the screen. Contact your HP Service and 
Support Center for assistance.

Press <F1> to resume, <F2> to Setup This is displayed after any recoverable error message. 
Press the F1 function key to start the boot process or the F2 
function key to enter BIOS Setup and change any settings.

Press <F2> to enter SETUP This is not an error message. Instead, it is an optional, 
informational message that is displayed during the 
controller’s power-on self-test (POST). Note that the display 
of this message can be turned off in BIOS Setup.

Previous boot incomplete - 
Default configuration used

The previous power-on self-test (POST) did not complete 
successfully. The POST then loads the default BIOS 
configuration values and offers to run BIOS Setup. If the 
failure was caused by incorrect BIOS values that were set 
and they are not corrected, the next boot will also likely fail. 
Therefore, ensure that all configuration values are re-set 
correctly in BIOS Setup. This error should then be cleared 
the next time the controller is booted. 

Table 2-2. BIOS Error Messages (Continued)

Error Message Description
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Real time clock error The real-time clock failed the system BIOS test. This may 
require repair of the board. Contact your HP Service and 
Support Center for assistance.

Shadow Ram Failed at offset: nnnn The shadow RAM failed at offset nnnn of the 64 KB block at 
which the error was detected. Contact your HP Service and 
Support Center for assistance.

System battery is dead - 
Replace and run SETUP

The CMOS clock battery indicator shows the battery is 
dead. Have the battery replaced (contact your HP Service 
and Support Center for assistance). Then run BIOS Setup 
to reconfigure the controller.

System cache error - Cache disabled The RAM cache failed the system BIOS test, and BIOS then 
disabled the cache. Contact your HP Service and Support 
Center for assistance.

System CMOS checksum bad - run SETUP The system CMOS has been corrupted or modified 
incorrectly, perhaps by an application program that changes 
data stored in CMOS. Run BIOS Setup and reconfigure the 
controller either by restoring the default values or the 
previous values and/or making your own selections.

System RAM Failed at offset: nnnn The system RAM failed at offset nnnn of the 64 KB block at 
which the error was detected. Contact your HP Service and 
Support Center for assistance.

System timer error The timer test failed. This requires repair of the system 
board. Contact your HP Service and Support Center for 
assistance.

Table 2-2. BIOS Error Messages (Continued)

Error Message Description
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Problems After Configuring the BIOS
If your controller either fails, does not work properly, or displays error 
messages after you make configuration changes in BIOS Setup, you may be 
able to correct the problem by entering BIOS Setup again and restoring 
either the original, default BIOS configuration values, or the previous 
values. This can be done via either the “Get Default Values” or the “Loa
Previous Values” selection in the Exit Menu of BIOS Setup. For more 
information, see the “Exit Menu” section of Chapter 3, “Using the BIOS 
Setup Utility”.

If after restoring the default or previous BIOS configuration values, your
controller is still not functioning properly, attempt to re-set the BIOS 
configuration values for your controller’s hardware setup by following th
appropriate information in Chapter 3, “Using the BIOS Setup Utility”. If th
still does not fix the problem, please contact your HP Service and Supp
Center for assistance.
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System Appears Hung Up
If the system appears to hang up after running normally, check the following 
conditions:

n Try switching the virtual consoles by using the Page Up and Page Down 
keys. The display should switch between the virtual consoles.

n If the controller has been running normally on a network, check if the 
controller answers a “ping” from another controller on the network.

If one condition works correctly, the other one should, too. If these 
conditions do not work; that is, if the consoles don’t switch, and the 
controller does not respond to a “ping” over the network, it is likely that t
problem is not in the user’s code. Neither of these checks will correct an
problem; however, the results do provide information about the system’s
condition for troubleshooting purposes.
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Using the BIOS Setup Utility

This chapter explains the various menus, sub-menus, and fields in the BIOS 
(Basic Input/Output System) Setup utility that you can use to configure the 
HP VXI Pentium Controller hardware. Since the controller is shipped with 
all BIOS Setup values pre-configured, you only need to use this chapter if 
you want to make changes to the pre-configured, default BIOS value 
settings.

This chapter presents each configuration menu, sub-menu, and field in the 
sequence that you would encounter it for the first time. Note that on-line 
help is also available in the Item Specific Help area of each menu and 
sub-menu.

Accessing BIOS Setup

Nonvolatile CMOS RAM in the controller maintains the BIOS settings that 
you save. The BIOS uses these settings to initialize the hardware.  You can 
access BIOS Setup only during the system reset process. To access BIOS 
Setup, press the F2 function key as the system boots.

Navigating BIOS Setup Menus

Within BIOS Setup, use the cursor (arrow) keys to navigate from menu to 
menu and to move between fields in a menu. Use the up and down cursor 
keys to move from field to field in a menu. Use the right and left cursor keys 
to move from menu to menu, as listed in the menu bar at the top of the BIOS 
Setup screen. If you leave a menu and then return, the active field is always 
at the top of the menu. If you select a sub-menu and then return to the main 
menu, note that you return to that sub-menu heading.
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Main BIOS Setup Menu
The Main BIOS Setup Menu is shown below.

The fields in this menu and its various sub-menus are as follows.

System Time:
and System Date: 

To change the values for these fields, simply move to each field and type in 
the desired entry.  Use the Tab key to move from hour to minutes to seconds, 
or from month to day to year.

Diskette A:
and Diskette B:

These fields identify the type of 3.5-inch disk drive installed as the A: and B: 
drives.  The BIOS defaults to 1.44 Mb, 3 ½”  for drive A:, and Not 
Installed  for drive B:.  Other possible values are: 360 Kb , 720 Kb , 1.2 
Mb, and 2.88 Mb .

IDE Adapter 0 
Master: and IDE 
Adapter 0 Slave: 
Sub-Menus

These fields are headings for sub-menus that allow you to enter complete 
disk drive information. Once the information is entered for the drive, the 
entry in the Main Menu shows the drive selected. For more information, see 
the “IDE Adapter 0 Sub-Menus” subsection later in this chapter.

PhoenixBIOS Setup - Copyright 1985-95 Phoenix Technologies Ltd.

Main Advanced Power EXM Exit

Item Specific Help
System Time: [16:17:18]
System Date: [03/01/96] <Tab>, <Shift-Tab>, or 

<Enter> selects field.Diskette A: [1.44 Mb, 3½”]
Diskette B: [Not Installed]

> IDE Adapter 0 Master (C: 1083 Mb)
> IDE Adapter 0 Slave (None)

Video System: [EGA / VGA]
> Memory Cache:
> Memory Shadow:
> Boot Sequence: [A: then C:]
> Numlock: [Off]

System Memory: 640 Kb
Extended Memory: 31 Mb

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Select > Sub-Menu F10 Previous Values

Figure 3-1. Main BIOS Setup Menu
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Video System: This field identifies the type of CRT monitor attached to the system. The 
possible values are:

EGA / VGA (default)
CGA 80x25
Monochrome

Memory Cache Sub-
Menu

For more information, see the “Memory Cache Sub-Menu” subsection la
in this chapter.

Memory Shadow 
Sub-Menu

The term “Memory Shadow” refers to the technique of copying informati
from an extension ROM into DRAM and accessing it in this alternate 
memory location. The controller restricts what memory is available for 
shadowing because of the special requirements for SCSI and the Univer
PCI/VME bridge.  For more information, see the “Memory Shadow Sub-
Menu” subsection later in this chapter.

Boot Sequence: 
Sub-Menu

The Boot Sequence Sub-Menu allows you to change the boot delay and
sequence, and to disable several displays during the boot process, such
SETUP prompt, POST (power-on self-test) errors, floppy drive check, an
summary screen.  Once the boot sequence has been set, it is displayed 
field of the Main Menu.  For more information, see the “Boot Sequence S
Menu” subsection later in this chapter.

Numlock:
Sub-Menu
(Keyboard Features) 

This sub-menu enables or disables various keyboard features, including
enabling the Num Lock key, enabling the key click, and setting the 
keyboard’s auto-repeat rate and delay.  The Numlock setting is displaye
this field in the Main BIOS Setup Menu.  For more information, see the 
“Keyboard Features Sub-Menu” subsection later in this chapter.

System Memory: This field is read-only (not editable) and displays the amount of 
conventional memory (below 1 MB).  No user interaction is required.  N
that the amount is actually less than 640 KB since some memory is use
the Extended BIOS Data Area, which is required for PS/2 mouse usage

Extended Memory: This field is also read-only and displays the amount of extended memor
(above 1 MB).  No user interaction is required.
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IDE Adapter 0 Sub-Menus

There are two IDE Adapter 0 Sub-Menus for the primary and secondary hard 
disk controllers, each having a master and slave drive screen. The detailed 
characteristics of the drive connected to the adapter is available in the IDE 
Adapter 0 Sub-Menu, which is shown below.

Note You must disable the IDE hard drive if you want to boot LynxOS using a 
SCSI drive.

Autotype Fixed Disk: This is a function which is used when setting up new disks. It allows BIOS 
Setup to determine the proper settings of the disk based on information on 
the disk. This information is detected by Setup for drives that comply with 
ANSI specifications.  Press the Enter key to invoke this function.

Existing (formatted) disks must be set up using the same parameters that 
were used originally when the disk was formatted.  If necessary, the specific 
Cylinder, Head, and Sectors/Track information, as listed on the label 
attached to the drive at the factory, must be entered manually on this sub-
menu using the User Type, which is described below.

PhoenixBIOS Setup - Copyright 1985-95 Phoenix Technologies Ltd.

Main

IDE Adapter 0 Master (C: 1038 Mb) Item Specific Help

Autotype Fixed Disk: [Press Enter] <Tab>, <Shift-Tab>, or 
<Enter> selects field.

Type: [User] 1083 Mb
Cylinders: [ 2100]
Heads: [   16]
Sectors/Track: [   63]
Write Precomp: [None]

Multi-Sector Transfers: [16 sectors]
LBA Mode Control: [Enabled]
32 Bit I/O: [Disabled]
Transfer Mode: [Fast PIO 4]

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Execute Command F10 Previous Values

Figure 3-2. IDE Adapter 0 Sub-Menus
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Type: Select None if there is no IDE hard disk drive for this adapter.  In the case 
where there is an IDE disk but the Autotype function (above) cannot be 
employed, then select the User type and enter the correct drive values for 
Cylinders, Heads, Sectors/Track, and Write Precomp (precompensation) for 
the drive.

Multi-Sector 
Transfers:

This field allows you to configure the System BIOS to read ahead by the 
specified number of sectors whenever a disk access is performed.  This has 
the effect of reading more data at once to reduce the absolute number of 
discrete disk reads performed by the operating system, which may increase 
system performance.  The possible values are: Disabled, or 2, 4, 8, or 
16  sectors (default).  Note that autotyping may change this value if the 
hard disk reports that it supports block accesses.

LBA Mode Control: When enabled, this field allows the System BIOS to reference hard disk data 
as logical blocks instead of using the traditional Cylinders/Heads/Sectors 
(CHS) method.  The Enabled value can only be used if both the hard disk 
being configured and the operating system support Logical Block 
Addressing (LBA).  If disabled, then CHS mode is used.  Note that 
autotyping may change this value if the hard disk reports that it supports 
LBA.  The default is Enabled.

32-bit I/O: When enabled, this field allows the System BIOS to access the hard disk 
controller with 32-bit I/O accesses, increasing system performance.  This 
field is not affected by autotyping.  The default is Disabled.

Transfer Mode: This field sets the mode that the System BIOS uses to access the hard disk. 
The possible values are:

Standard
Fast PIO 1
Fast PIO 2
Fast PIO 3
Fast PIO 4 (default)
Fast DMA

Older hard disks only support the Standard setting. Newer hard disks 
adhering to Fast ATA or Enhanced IDE specifications may support the 
Fast PIO (programmed I/O) modes. The Fast DMA mode makes full use 
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of the onboard bus mastering hard disk controller and should yield the 
highest performance when used in conjunction with multi-tasking operating 
systems that support it. Note that autotyping may change this value 
depending on the transfer modes that the hard disk reports it supports.

Memory Cache Sub-Menu

This sub-menu controls the cachability of certain memory regions, as well as 
the settings of the Level 2 (L2) cache. The Memory Cache Sub-Menu is 
shown below.

External Cache: This field enables or disables the Level 2 (L2) cache.  If this cache is 
disabled, system performance will suffer. The default is Enabled.

Cache System BIOS 
Area:

This field enables or disables caching of the System BIOS area in the 
0E4000H through 0FFFFFH DRAM area.  If this cache is disabled, system 
performance will suffer. The default is Enabled.

Cache Video BIOS 
Area:

This field enables or disables caching of the VGA BIOS area in the 
0C0000H through 0C7FFFH region.  If this cache is disabled, system 
performance will suffer. The default is Enabled.

PhoenixBIOS Setup - Copyright 1985-95 Phoenix Technologies Ltd.

Main

Memory Cache Item Specific Help

External Cache: [Enabled] <Tab>, <Shift-Tab>, or 
<Enter> selects field.

Cache System BIOS Area: [Enabled]
Cache Video BIOS Area: [Enabled]

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Select > Sub-Menu F10 Previous Values

Figure 3-3. Memory Cache Sub-Menu
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Memory Shadow Sub-Menu

The term “shadowing” refers to the technique of copying code, such as 
BIOS extensions, from ROM into DRAM and accessing them from DRA
This allows the CPU to access the BIOS extensions faster and generall
increases system performance if many calls to the BIOS extensions are
made. The Memory Shadow Sub-Menu is shown below.

System Shadow: This field is read-only (not editable) since the System BIOS is always 
shadowed.

Video Shadow: While it is advisable to leave video shadowing enabled, it is possible to 
disable video shadowing for system performance reasons. The default i
Enabled.

Regions with 
Legacy Expansion 
ROMs:

These fields enable a ROM or disable shadowing for the associated me
region.  There are four 16 KB areas where expansion ROMs can be 
shadowed:

D000 - D3FF
D400 - D7FF
D800 - DBFF
DC00 - DFFF

PhoenixBIOS Setup - Copyright 1985-95 Phoenix Technologies Ltd.

Main

Memory Shadow Item Specific Help

System Shadow:  Enabled <Tab>, <Shift-Tab>, or 
<Enter> selects field.Video Shadow: [Enabled]

Regions with Legacy Expansion ROMs:

D000-D3FF: [Rom]
D400-D7FF: [Rom]
D800-DBFF: [Rom]
DC00-DFFF: [Rom]

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Select > Sub-Menu F10 Previous Values

Figure 3-4. Memory Shadow Sub-Menu
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The default for each of these is ROM.

The shadow regions should be used only if an EXMbus card is installed in 
the system that contains a BIOS extension (ROM), although there is no 
effect on the system if a region is shadowed that does not contain a BIOS 
extension.  Note that each shadow region in the Setup menu is 16 KB in size.  
Multiple shadow regions may have to be enabled if the BIOS extension to be 
shadowed is larger than 16 KB.

Boot Sequence Sub-Menu

The Boot Sequence Sub-Menu allows you to change options for the boot 
sequence. This sub-menu is shown below.

Boot Delay: This field sets the system to delay booting for a time period in seconds.  This 
allows for long start-up times on boot devices that spin up slowly.  The 
default is 0 (zero) seconds.

Floppy Check: This field enables or disables the floppy (3.5-inch disk) drive search during 
the boot.  To speed up booting, the floppy check should be disabled.  It is 
still possible to boot from the A: drive even with the floppy check disabled. 
The default is Disabled.

PhoenixBIOS Setup - Copyright 1985-95 Phoenix Technologies Ltd.

Main

Boot Options Item Specific Help

Boot Delay: [  0] <Tab>, <Shift-Tab>, or 
<Enter> selects field.Floppy Check: [Disabled]

Boot Sequence: [A: then C:]
SETUP Prompt: [Enabled]
POST Errors: [Enabled]
Summary Screen: [Enabled]

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Select > Sub-Menu F10 Previous Values

Figure 3-5. Boot Sequence Sub-Menu
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Boot Sequence: This field defines how the system treats the floppy A: drive when booting. 
Booting can occur either from a floppy disk in the A: drive, or directly from 
the C: fixed disk drive. To reduce the amount of time required to boot, set the 
boot sequence to C: only. Note that the C: drive may be either an IDE or 
SCSI drive. The possible values are:

SETUP Prompt: This field enables or disables the message Press F2 to enter Setup. 
Even if the message is disabled, you can still press the F2 function key at the 
appropriate time to enter the Main BIOS Setup Menu. To speed up booting, 
disable the SETUP Prompt. The default is Enabled.

POST Errors: When enabled, this field is used to stop progress during the boot process if 
the POST (power-on self-test) encounters errors.  Otherwise, the system 
continues to attempt to boot despite any start-up error messages that are 
displayed.  Note that this field only affects those errors that are configured at 
build-time to halt the system. The default is Enabled.

Summary Screen: This field is used to enable or disable a summary of the system 
configuration, which is displayed before the operating system starts to load.  
To speed up booting, disable the Summary Screen.  The default is Enabled.

A: then 
C: (default)

Used to boot from the floppy drive or, if no floppy disk is 
present in the A: drive, to boot from the C: drive. This is useful 
for troubleshooting the operating system if a boot disk is in 
drive A:.

C: then A: Used to boot from the C: drive or, if not present, to boot from 
the A: drive.

C: only Used to boot from the C: drive without searching for an A: 
drive.
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Keyboard Features Sub-Menu

This sub-menu, which is accessed from the Numlock: field in the Main 
BIOS Setup Menu, enables or disables various keyboard features. The 
Keyboard Features Sub-Menu is shown below.

Numlock: This field enables or disables the Numlock feature of the keyboard at boot 
time.  When enabled, Numlock permits the use of the keypad numbers on 
the keyboard.  The default is Off, which disables the Numlock key at boot 
time.

Key Click: This field enables or disables the key click feature on the keyboard. When 
enabled, the system produces an audible click each time a key is pressed. 
The default is Disabled.

Keyboard auto-
repeat rate:

This field sets the auto-repeat rate when a key is held down on the keyboard. 
The rates range from 2-30 per second.  The default rate is 30/sec.

Keyboard auto-
repeat delay:

This field sets the delay between when a key is pressed and when the auto-
repeat feature begins.  Options are 1/4, 1/2, 3/4, and 1 (one) second.  The 
default delay is 1/4 sec.
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Main

Keyboard Features Item Specific Help

Numlock; [Off] <Tab>, <Shift-Tab>, or 
<Enter> selects field.Key Click: [Disabled]

Keyboard auto-repeat rate: [30/sec]
Keyboard auto-repeat delay: [1/4 sec]

F1  Help  ↑  ↓    Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Select > Sub-Menu F10 Previous Values

Figure 3-6. Keyboard Features Sub-Menu
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The Advanced Menu contains settings for integrated peripherals, memory 
shadow, cache, and large disk access mode. The Advanced Menu is shown 
below.

Integrated 
Peripherals Sub-
Menu

This sub-menu is used to configure the onboard serial (COM) and parallel 
(LPT) ports, as well as the onboard disk controllers.  For more information, 
see the “Integrated Peripherals Sub-Menu” subsection later in this chap

Advanced Chipset 
Control Sub-Menu

This sub-menu is used to configure the chipset.  For more information, s
the “Advanced Chipset Control Sub-Menu” subsection later in this chap

Plug & Play O/S: If enabled, this field informs the System BIOS that the operating system
which is booted supports Plug and Play.  This forces the Plug and Play 
portion of the System BIOS to only configure motherboard devices and 
those peripherals that are necessary for booting (display, hard disk, and
forth), the rest being left to the operating system to configure.  The defau
No (disabled).

PhoenixBIOS Setup - Copyright 1985-95 Phoenix Technologies Ltd.

Main Advanced Power EXM Exit

Item Specific Help
Warning!

Setting items on this menu to incorrect values <Tab>, <Shift-Tab>, or 
<Enter> selects field.may cause your system to malfunction.

>Integrated Peripherals:
>Advanced Chipset Control:
Plug & Play O/S: [No]
Reset Configuration Data: [No]

Level 1 Cache: [Enabled]

Large Disk Access Mode: [DOS]

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Select > Sub-Menu F10 Previous Values

Figure 3-7. Advanced Menu
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Reset Configuration 
Data:

If enabled, this field updates the Extended System Configuration Data 
(ESCD) block residing in FBD main block #2.  This is necessary the first 
time a system is turned on or if the ESCD becomes corrupted.  The default is 
No (disabled).  This field is automatically reset to No after the ESCD is 
updated.

Level 1 Cache: When enabled, this field speeds up the processor by enabling the Level 1 
(L1) cache.  If the L1 cache is disabled, system performance will suffer. The 
default is Enabled.

Large Disk Access 
Mode:

If a hard disk larger than 528 MB is being used, this field should be set either 
to DOS (the default) if running MS-DOS®, or to Other if using a different 
operating system. Setting this field to DOS causes the system BIOS to 
perform cylinder/head translation if the drive is configured in BIOS Setup
have more than 1024 cylinders. This allows MS-DOS systems to use ha
disks up to 8 GB (1024C X 255H X 63S) in size without special drivers o
LBA.
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Integrated Peripherals Sub-Menu

This sub-menu is used to configure the onboard serial (COM) and parallel 
(LPT) ports, as well as the onboard disk controllers. The Integrated 
Peripherals Sub-Menu is shown below.

COM port: This field configures the serial port labeled “COM1” on the front panel.  T
defaults for this COM port are I/O base 3F8H and IRQ4.

LPT port: This field configures the parallel port labeled “LPT” on the front panel. T
defaults for this LPT port are I/O base 378H and IRQ5.

LPT Mode: This field sets the mode under which the LPT port operates.  The select
are:

Output only
Bi-Directional (default)
ECP

Diskette Controller: This field enables or disables the onboard 3.5-inch disk (floppy) drive 
controller.  The default is Enabled.
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Advanced

Integrated Peripherals Item Specific Help

COM port: [3F8, IRQ 4] <Tab>, <Shift-Tab>, or 
<Enter> selects field.LPT port: [378, IRQ 5]

LPT Mode: [Bi-Directional]
Diskette controller: [Enabled]
Local Bus IDE adapter: [Enabled]

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Select > Sub-Menu F10 Previous Values

Figure 3-8. Integrated Peripherals Sub-Menu
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Local Bus IDE 
adapter:

This field enables or disables the onboard PCIbus IDE hard disk controller. 
The default is Enabled.

Advanced Chipset Control Sub-Menu

This sub-menu allows you to control selected settings for the chipset that 
affect performance or function. The Advanced Chipset Control Sub-Menu is 
shown below.

DRAM Speed: This field sets the speed of the installed DRAM SODIMMs. Selecting 70 ns 
for 60 ns SODIMMs decreases performance. Selecting 60 ns for 70 ns 
SODIMMs is invalid. The default is 60ns.

DMA Aliasing: This field allows I/O accesses to the range 90-9FH (except 92H) to alias to 
80-8FH.  If an ISAbus device uses the address range 90-9FH, then this field 
must be disabled to access the device.  The default is Enabled.

8-bit I/O Recovery: This field selects the number of ISAbus SYSCLKs to be inserted by the 
chipset between 8-bit back-to-back I/O accesses.  Increasing the number of 
clocks decreases I/O performance but may allow slow devices to be accessed 
properly. Values can range from 3.5 through 11.5 SYSCLKs, in 1 
SYSCLK increments. The default is 4.5 SYSCLKs.
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Advanced

Advanced Chipset Control Item Specific Help

DRAM Speed: [60ns] <Tab>, <Shift-Tab>, or 
<Enter> selects field.DMA Aliasing: [Enabled]

8-bit I/O Recovery: [4.5]
16 bit I/O Recovery: [4.5]
IRQ12 used by: [PS/2 Mouse]
ECC/Parity Config: [Disabled]

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Select > Sub-Menu F10 Previous Values

Figure 3-9. Advanced Chipset Control Sub-Menu
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16-bit I/O Recovery: This field selects the number of ISAbus SYSCLKs to be inserted by the 
chipset between 16-bit back-to-back I/O accesses.  Increasing the number of 
clocks decreases I/O performance but may allow slow devices to be accessed 
properly. Values can range from 3.5 through 7.5 SYSCLKs, in 1 SYSCLK 
increments. The default is 4.5 SYSCLKs.

IRQ 12 used by: This field selects the routing of IRQ12.  For systems without a PS/2 mouse, 
this field may be set to ISA bus to allow an ISAbus peripheral to use this 
interrupt line.  Systems using a PS/2 mouse must have this field set to PS/2 
Mouse (the default) for the mouse to operate correctly.

ECC/Parity Config: This field configures the DRAM controller to use no parity (Disabled), 
parity (Parity), or Error Checking and Correction (ECC) when accessing 
DRAM.  Use of parity or ECC may improve system reliability since DRAM 
errors are likely to be detected by the chipset.  Use of ECC allows for the 
detection of single and dual bit errors and the correction of single bit errors 
during DRAM reads.  The parity and ECC selections require that all 
SODIMMs be x36 instead of x32.  The no parity (disabled) selection can use 
either x32 or x36 SODIMMs. The default is Disabled. (Note that the VXI 
Pentium Controller is shipped with non-parity x32 DRAM.)
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 Power Management Menu
This menu provides control over the power management facilities. As shown 
below, only about one-half of the Power Management Menu fields are 
visible at any one time; however, for completeness, all of the menu fields are 
listed and explained in this section. Use the Page Up and Page Down keys 
to display the other page of fields.

Note that the supported states for system BIOS Power Management are: 
Fully On, Standby Mode (partial power reduction), and Suspend Mode 
(maximum power reduction). Also note that the Power Management features 
are not implemented in the default setups.

APM: This field enables or disables Advanced Power Management (APM).  The 
default is Disabled.
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Main Advanced Power  EXM    Exit

APM: [Disabled] Item Specific Help
Power Savings: [Disabled]

<Tab>, <Shift-Tab>, or 
<Enter> selects field.Standby Timeout: Disabled

Suspend Timeout: DIsabled
Standby CPU Speed: MAX
Fixed DIsk Timeout: Disabled
CRT: ON

Standby Timer Reset Events
Keyboard: [Enabled]
Mouse: [PS/2 (IRQ12)]

Standby Break Events
IRQ0: [Disabled]
IRQ1: [Auto]
IRQ3: [Auto] V

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Select > Sub-Menu F10 Previous Values

Figure 3-10. Power Management Menu
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Power Savings: This field enables and selects the kind of power management, or it disables 
power management.  The possible values are:

Disabled (default)
Customize
Maximum
Medium
Minimum

Standby Timeout: This field enables and sets the inactivity duration required to elapse before 
the system is placed into Standby Mode, or it disables the Standby Timeout. 
The possible values are:

Disabled (default)
2 minutes
15 minutes
30 minutes
1 hour
2 hours
3 hours
4 hours

Suspend Timeout: This field enables and sets the inactivity duration required to elapse before 
the system is placed into Suspend Mode from Standby Mode, or it disables 
the Suspend Timeout.  The values are the same as for the Standby Timeout, 
listed above.  The default is Disabled.

Standby CPU 
Speed:

This field enables or disables the changing of the CPU speed based upon the 
current power management state.  The possible values are:

Disabled
LOW
MEDIUM
HIGH
MAX (default)

Fixed Disk Timeout: This field enables and sets the inactivity duration of fixed disk accesses 
required to elapse before the system shuts off the disk drive, or it disables the 
Fixed Disk Timeout.  The possible values are: Disabled (default), or 1, 2,  
3, 4, 5, 10, or 16 minutes.
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Power Management Menu
CRT: This field enables or disables power management of the CRT during system 
entry or exit into or from Standby Mode. The possible values are: OFF in 
Standby and ON in Standby. The default is ON.

Standby Timer 
Reset Events

This group of fields enables or disables whether or not activity from the 
specified device causes the Standby Timer to be reset or not. The default is 
Enabled.

Keyboard: This field enables or disables keyboard activity to reset the 
Standby Timer or not. The possible values are: Enabled (default) and 
Disabled.

Mouse: This field enables or disables mouse activity to reset the Standby 
Timer or not.  The possible values are:

Disabled
PS/2 (IRQ12) (default)
COM1 (IRQ4)
COM2 (IRQ3)

Standby Break 
Events

This group of fields enables or disables a Standby Break Event for the 
specified IRQ.  A Standby Break Event allows the system to run at full speed 
for the duration of the specified IRQ.  Note that no such event is associated 
with IRQ2.

IRQ0-15: Each of these fields enables or disables the Standby Break Event for each 
IRQ. The possible values are: Disabled and Auto. The default setting for 
IRQ 1, 3, 4, and 12 is Auto. The default setting for all other IRQs is 
Disabled.

Standby Wakeup 
Events

This group of fields enables or disables the keyboard or mouse to cause a 
Standby Wakeup Event -- that is, these fields allow keyboard or mouse 
activity to return the system to full speed.

Keyboard: This field enables or disables the Standby Wakeup Event for the 
keyboard. The possible values are: Enabled (default) and Disabled.
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Power Management Menu
Mouse: This field enables and selects the IRQ that the mouse is bound to for 
the purposes of mouse activity detection for power management, or disables 
the Standby Wakeup Event for the mouse.  The possible values are:

PS/2 (IRQ12) (default)
COM1 (IRQ4)
COM2 (IRQ3)
Disabled
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EXM Menu
 EXM Menu
The fields in this menu allow you to change the settings for the EXM 
module in the system. The VXI Pentium Controller comes with an HP-22 
GPIB interface module installed in EXM Slot 1 by default. The EXM Menu 
is shown below.

ID: This field selects the EXM-ID for the HP-22 GPIB expansion module. The 
default is FF for Slot 0 and D9 for Slot 1.

Option Byte 1: This field selects the I/O address selection for the HP-22. The default is FF, 
which corresponds to the I/O address 370-377, 770-777, B70-B77, and F70-
F77. Other possible values are:

To disable the HP-22, enter 00.
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Main Advanced Power EXM Exit

Item Specific Help
EXM Slot 0
    ID: [FF] <Tab>, <Shift-Tab>, or 

<Enter> selects field.    Option Byte 1: [00]
    Option Byte 2: [00]

EXM Slot 1
    ID: [D9]
    Option Byte 1: [FF]
    Option Byte 2: [00]

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Select > Sub-Menu F10 Previous Values

Figure 3-11. EXM Menu

F9 250-257, 650-657, A50-A57 and E50-E57

FB 270-277, 670-677, A70-A77, and E70-E77

FD 350-357, 750-757, B50-B57, and F50-F57
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EXM Menu
Option Byte 2: This field is set to 00 (disabled/unused).

Caution To configure a second HP-22 card in EXM Slot 0, make sure that it is not 
sharing the same I/O address as the first card pre-installed in EXM Slot 1. 
For information on configuring a second card, see the hardware reference 
manual shipped with the card.
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Exit Menu
 Exit Menu
The fields in this menu allow you to save value settings and exit BIOS 
Setup, or abandon value changes and exit. The Exit Menu is shown below.

Save Changes & 
Exit

This field is used to save into CMOS the values that have been entered. The 
system then immediately reboots with the new values.

Exit Without Saving 
Changes

This field is used to discard the changes just made and revert to the state 
when BIOS Setup was first entered.  The system reboots with the old values.

Get Default Values This field is used to reset the BIOS Setup values to the original, default 
values that were set at the factory, before any suppliers or other end-users 
made changes. This is useful if you are having problems with the system and 
suspect changes made to the BIOS are the cause.

Load Previous 
Values

This field is used to load the system with the previous values before an 
editing session started. This is useful if you lose track of edits and want to 
revert to the previous editing session, but not all the way back to the 
defaults.
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Main Advanced Power EXM Exit

Item Specific Help
Save Changes & Exit
Exit Without Saving Changes <Tab>, <Shift-Tab>, or 

<Enter> selects field.Get Default Values
Load Previous Values
Save Changes

F1  Help  ↑  ↓   Select Item -/+   Change Values F9  Setup Defaults
ESC Exit ← → Select Menu Enter Execute Command F10 Previous Values

Figure 3-12. Exit Menu
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Exit Menu
Save Changes This field is used to save the edits made during a session. You do not exit, 
and you can continue to make changes.
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Re-Installing the System Software

The HP E6237A VXI Pentium Real-Time Controller arrives from the 
factory with the entire system software installed and configured. The system 
software includes the LynxOS real-time operating system, HP SICL for 
LynxOS, HP C-SCPI for LynxOS, and software from the Free Software 
Foundation. This chapter explains the process you should follow if you need 
to re-install the system software for any reason.

To complete the installation, locate the required installation media, then run 
the installation program and follow the instructions displayed on the system 
monitor. The entire procedure will take about 30 minutes. When the 
installation is done, your system will contain the same software and be 
configured as it was when it arrived from the factory. After you finish the re-
installation, see Chapter 1, “Getting Started,” for information about 
changing LynxOS configuration settings.

Caution All data on the controller hard drive will be destroyed when you re-install 
the system software. Be sure to back up data you want to keep onto oth
media before starting this procedure.
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To Prepare for the Re-Installation
Locate the following materials that were packed with the HP E6237A VXI 
Pentium Real-Time Controller.

n The CD-ROM labeled “E6237A Development System”. This contains
the system software.

n The 3.5-inch floppy disk labeled “E6237A Installation Disk”. This is th
LynxOS boot disk.

n The booklet, HP E6237A Development System Software License Terms, 
containing the license terms for the system software. The installation
program will ask if you have accepted the terms before it will install th
software.

Continue to the next section.
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To Re-Install the System Software
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To Re-Install the System Software

1. If the controller is running, enter the following command to shutdown the 
controller before turning off the power (you must have root privileges to 
reboot):

reboot -h

After the disk activity has stopped, and you see the following message, 
turn off the power using the switch on the VXI mainframe:

**** LynxOS is down ****

2. Attach a CD-ROM drive to the SCSI connector on the controller’s 
faceplate.

3. Insert the CD-ROM into the CD-ROM drive.

4. Insert the LynxOS boot disk into the controller’s disk drive.

5. Turn on the controller’s power using the switch on the VXI mainframe
The controller will boot the LynxOS preboot program from the floppy 
disk, then load and run the kernel. When this is done, the installation
program will prompt you for responses to questions.

6. Follow the prompts displayed on the system monitor. Type your 
responses using the keyboard. Press Enter at the end of each response. A
each prompt you can quit the installation process if you need to start
over. The final prompt will tell you when the software is installed, and
how to reboot the controller.

Note The boot disk also contains the LynxOS file system. At the final prom
please do not remove the disk until you see the following message

**** LynxOS is down ****
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LEDs on the Front Panel

There are seven LED indicators on the front panel of the VXI Pentium 
Controller which provide information about the state of the controller. The 
following table lists the label, color, and meaning of each LED indicator.

Table A-1. LED Indicators

Label Color Meaning

 RUN Green Lit whenever a write access is made to DRAM. 
If not lit, either the CPU is executing entirely out 
of the on-chip cache, or the CPU is halted.

SYSFAIL Red Lit whenever the VME SYSFAIL line is 
asserted.

TEST Yellow Reflects the state of the PASS bit in the VXI 
registers. TEST is lit when controller boots, then 
goes out during boot after controller passes 
self-test. If not lit during boot, or remains lit after 
boot, then controller failed self-test.

MASTER Green Lit when a VME access is made by this device 
as a master.

SLAVE Green Lit when another VME device accesses the 
memory of this controller.

SCSI Green Lit when the SCSI port is busy.

IDE Green Lit when the IDE disk is busy.
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I/O, Memory, and IRQ Details

This appendix provides more detailed technical descriptions of the following 
for the VXI Pentium Controller:

n VGA video controller, including its BIOS extension
n SCSI controller, including its BIOS extension
n Ethernet controller
n Memory map
n IRQs (interrupts)

VGA Video Controller

The VXI Pentium Controller contains the Cirrus CL-GD5436 or 
CL-GD5446, PCI-based, super-VGA compatible video graphics controller 
with 2 MB of display memory. The VGA video controller resides on the 
PCIbus and is PCI device number 1.

The Video BIOS extension is shadowed and write-protected in the region 
0x0C0000 to 0x0C7FFF (32 KB) on any system reset or power-up. The 
features of the Video BIOS include:

n Standard VGA modes up to 640 X 480 resolution with 16.8 million 
colors.

n Super-VGA modes up to 800 X 600 resolution with 16.8 million colors.

n Extended video modes up to 1280 X 1024 resolution with 256 colors 
(non-interlaced).
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SCSI Controller

An AMD53C974A is used to implement the SCSI controller in the VXI 
Pentium Controller. The SCSI BIOS extension is automatically shadowed in 
system DRAM at memory location 0x0C8000 to 0x0CFFFF. In the BIOS 
setup utility, SCSI hard disk enumeration begins with the logical drive C:, 
continuing with drives A: and B: if there are two 3.5-inch disk drives 
connected to the IDEbus. However, after LynxOS boots, these drive 
enumerations are meaningless; LynxOS uses LynxOS-specific device 
names. The LynxOS User’s Guide describes the device naming convention. 
Using this convention, the name for a SCSI hard drive attached to the VXI 
Pentium Controller at SCSI address 0 is:

/dev/sd974.0

The SCSI device resides on the PCIbus and is mapped as PCI device number 
3. The SCSI controller uses PCIbus interrupt INTC. The default I/O base 
address and interrupt is 0xC180 and IRQ11, respectively.

The SCSI BIOS extension supports booting LynxOS from the SCSI 
controller. However, this is not a typical configuration since LynxOS is 
usually installed on the built-in IDE drive.

Ethernet Controller

The Ethernet controller is implemented using the AMD79C970A. The 
Ethernet controller resides on the PCIbus and is mapped as PCI device 
number 2. It uses PCIbus interrupt INTB. The Ethernet ID is stored in a 
PROM (8-pin serial data) that is connected to the AMD79C970A. The I/O 
base address, interrupt, and DMA channel are at 0x0300, IRQ15, and 
DMA5, respectively.

Network booting is not supported.

The Ethernet port supports only a 10-base-T interface.
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Memory Map

The following table summarizes the VXI Pentium Controller memory map.

a. All addresses are hexadecimal.

Table B-1. Memory Map

Pentium Address Rangea Region Cached

00000000-0009FFFF DRAM Yes

000A0000-000BFFFF VGA Memory No

000C0000-000C7FFF Shadowed VGA BIOS Yes

000C8000-000CFFFF Shadowed SCSI BIOS Yes

000D0000-000DFFFF On-board EXMbus No

000E0000-000E3FFF VXI Interface Chip No

00100000-07FFFFFF DRAM Yes

08000000-0FFFFFFF EXMbus No

10000000-1FFFFFFF Reserved No

20000000-3FFFFFFF Reserved No

40000000-7FFFFFFF Reserved No

80000000-83FFFFFF VXI Interface Chip Image 0 No

84000000-87FFFFFF VXI Interface Chip Image 1 No

88000000-8BFFFFFF VXI Interface Chip Image 2 No

8C000000-8FFFFFFF VXI Interface Chip Image 3 No

90000000-93FFFFFF VXI Interface Chip Image 4 No

94000000-EFFFFFFF Reserved No

F0000000-FFF7FFFF EXMbus No

FFF80000-FFFFFFFF Flash Boot Device No
56 Appendix B 



I/O, Memory, and IRQ Details
IRQs (Interrupt Request Lines)

The following table lists the IRQs for the VXI Pentium Controller.

Table B-2. IRQs (Interrupt Request Lines)

Interrupt Source

 IRQ0 Timer

IRQ1 Keyboard Controller

IRQ2 Cascade Interrupt Input

IRQ3 COM2 (Not externally available)
Use for second HP-22 on Lynx, or for a different EXM card.

IRQ4 COM1

IRQ5 ECP Printer Port (LPT1)

IRQ6 3.5-inch Disk Drive

IRQ7 HP-22

IRQ8 Real-time Clock

IRQ9 VXI Interface Chip

IRQ10 VXI Interface Chip

IRQ11 SCSI

IRQ12 Mouse

IRQ13 Numeric Co-processor

IRQ14 IDE

IRQ15 Ethernet

NMI EXMbus I/O Channel Check Asserted

SMI Power Management

INTA VGA (not mapped)

INTB Ethernet (mapped to IRQ15)

INTC SCSI (mapped to IRQ11)

INTD VXI Interface Chip (mapped to IRQ9)
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POST Beep Codes

This appendix lists the codes that are written to the diagnostic port of the 
HP VXI Pentium Controller during the power-on self-test (POST) phase of 
the system boot.

The POST Codes listed in the tables below are viewable only by HP service 
personnel with the proper diagnostic equipment.

The audible Beep Codes listed in the tables below will be issued only when 
the associated self-test detects a failure. This information, if available, is 
useful to the HP Service and Support Center when you report a problem.

Phoenix NuBIOS Checkpoints

The Phoenix NuBIOS writes a number of checkpoints to I/O port 80h just 
before each self-test is executed. Note that the execution order of the POST 
tests generally follows the order listed in the tables below, but not exactly.

Table C-1. Phoenix NuBIOS Checkpoint Codes

Beep 
Code

POST 
Code

Checkpoint Description

 02h Verify Real Mode

 04h Get CPU type

 06h Initialize system hardware

 08h Initialize chipset registers with initial POST values

 09h Set in POST flag

 0Ah Initialize CPU registers

 0Ch Initialize cache to initial POST values

 0Eh Initialize I/O

 10h Initialize Power Management

 11h Load alternate registers with initial POST values

 12h Jump to UserPatch0
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 14h Initialize keyboard controller

1-2-2-3 16h BIOS ROM checksum

 18h 8254 timer initialization

 1Ah 8237 DMA controller initialization

 1Ch Reset Programmable Interrupt Controller

1-3-1-1 20h Test DRAM refresh

1-3-1-3 22h Test 8742 Keyboard Controller

 24h Set ES segment to register to 4GB

 28h Autosize DRAM

 2Ah Clear 512KB base RAM

1-3-4-1 2Ch Test 512KB base address lines

1-3-4-3 2Eh Test 512KB base memory

 32h Test CPU bus-clock frequency

 37h Reinitialize the chipset

 38h Shadow system BIOS ROM

 39h Reinitialize the cache

 3Ah Autosize cache

 3Ch Configure advanced chipset registers

 3Dh Load alternate registers with CMOS values

 40h Set Initial CPU speed

 42h Initialize interrupt vectors

 44h Initialize BIOS interrupts

2-1-2-3 46h Check ROM copyright notice

 47h Initialize manager for PCI Option ROMs

 48h Check video configuration against CMOS

Table C-1. Phoenix NuBIOS Checkpoint Codes (Continued)

Beep 
Code

POST 
Code

Checkpoint Description
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 49h Initialize PCI bus and devices

 4Ah Initialize all video adapters in system

 4Ch Shadow video BIOS ROM

 4Eh Display copyright notice

 50h Display CPU type and speed

 52h Test keyboard

 54h Set key click if enabled

 56h Enable keyboard

2-2-3-1 58h Test for unexpected interrupts

 5Ah Display prompt “Press F2 to enter SETUP”

 5Ch Test RAM between 512KB and 640KB

 60h Test extended memory

 62h Test extended memory address lines

 64h Jump to UserPatch1

 66h Configure advanced cache registers

 68h Enable external and CPU caches

 6Ah Display external cache size

 6Ch Display shadow message

 6Eh Display non-disposable segments

 70h Display error messages

 72h Check for configuration errors

 74h Test real-time clock

 76h Check for keyboard errors

 7Ch Set up hardware interrupts vectors

 7Eh Test coprocessor if present

Table C-1. Phoenix NuBIOS Checkpoint Codes (Continued)

Beep 
Code

POST 
Code

Checkpoint Description
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 80h Disable onboard I/O ports

 82h Detect and install external RS232 ports

 84h Detect and install external parallel ports

 86h Re-initialize onboard I/O ports

 88h Initialize BIOS Data Area

 8Ah Initialize Extended BIOS Data Area

 8Ch Initialize floppy controller

 90h Initialize hard disk controller

 91h Initialize localbus hard disk controller

 92h Jump to UserPatch2

 94h Disable A20 address line

 96h Clear huge ES segment register

 98h Search for option ROMs

 9Ah Shadow option ROMs

 9Ch Set up Power Management

 9Eh Enable hardware interrupts

 A0h Set time of day

 A2h Check keylock

 A8h Erase F2 prompt

 AAh Scan for F2 keystroke

 ACh Enter SETUP

 AEh Clear in-POST flag

 B0h Check for errors

 B2h POST done--prepare to boot operating system

 B4h One beep

Table C-1. Phoenix NuBIOS Checkpoint Codes (Continued)

Beep 
Code

POST 
Code

Checkpoint Description
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 B6h Check password (optional)

 B8h Clear global descriptor table

 BCh Clear parity checkers

 BEh Clear screen (optional)

 BFh Check virus and backup reminders

 C0h Try to boot with INT19

Table C-2. Phoenix NuBIOS Auxiliary Checkpoint Codes

Beep 
Code

POST 
Code

Checkpoint Description

 D0h Interrupt handler error

 D2h Unknown interrupt error

 D4h Pending interrupt error

 D6h Initialize option ROM error

 D8h Shutdown error

 DAh Extended Block Move

 DCh Shutdown 10 error

Table C-1. Phoenix NuBIOS Checkpoint Codes (Continued)

Beep 
Code

POST 
Code

Checkpoint Description
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Table C-3. Phoenix NuBIOS Boot Block Checkpoint Codes

Beep 
Code

POST 
Code

Checkpoint Description

 E2h Initialize the chipset

 E3h Initialize refresh counter

 E4h Check for Forced Flash

 E5h Check HW status of ROM

 E6h BIOS ROM is OK

 E7h Do a complete RAM test

 E8h Do OEM initialization

 E9h Initialize interrupt controller

 EAh Read in bootstrap code

 EBh Initialize all vectors

 ECh Boot the Flash program

 EDh Initialize the boot device

 EEh Boot code was read OK
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Specifications
Environmental

The following table defines the environmental specifications for the I/O base 
board in the VXI Pentium Controller. 

Table D-1. Environmental Specifications

Characteristic Operating Value Non-Operating 
(Storage) Value

Temperature 5°C to 45°C, derated 2°C 
per 1,000 feet (300 
meters) over 10,000 feet 
(3,000 meters); 2°C per 
minute maximum 
excursion gradient

-40°C to +65°C, 5°C per 
minute maximum 
excursion gradient

Humidity 8% to 90% non-
condensing

5% to 95% non-
condensing

Altitude 0 to 10,000 feet (3,000 
meters)

0 to 40,000 feet (12,000 
meters)

Vibration 0.015 inch (0.38 mm) P-P 
displacement with 2.5 g 
peak (maximum) 
acceleration over 5 to 300 
Hz

0.030 inch (0.76 mm) P-P 
displacement with 5.0 g 
peak (maximum) 
acceleration over 5 to 300 
Hz

Shock 30 g, 11 ms duration, 
half-sine shock pulse

50 g, 11 ms duration, 
half-sine shock pulse
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Electrical

The following table defines the electrical specifications for the controller
I/O base board.

Table D-2. VXI Pentium Controller Power Requirements

Voltage DC Current Dynamic Current

+5 V dc 11 A 0.31 A

+12 V dc 40.2 mA 0.08 A

-12 V dc 2.4 mA 0.03 A

-2 V dc 120 mA 0.08 A

-5.2 V dc 335 mA 0.192 mA
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